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SAS Commands under OpenVMS
During an interactive SAS session, you can issue commands from the SAS command

line or from the SAS command window. SAS supports many commands that help you
navigate through your session and accomplish certain tasks. In many cases, the
command is simply another way to invoke an action that you can also accomplish by
using the SAS menus and windows. However, advanced users might find that the
supported commands are a more efficient way to work. Sometimes commands offer a
more flexible way to accomplish a task when the parameters of your task are different
from those that the SAS interface supports.

There are two main types of commands available under OpenVMS: SAS windowing
environment commands and SAS Text-Editor commands. The SAS windowing
environment commands control window management, file management, the toolbox,
dialog boxes, color, and output. The SAS Text-Editor commands control how text is
manipulated, such as upper- and lowercase, cutting, copying and pasting.

Most SAS commands are described in the SAS online Help. The commands that are
described here have syntax or behavior that is specific to the OpenVMS operating
environment.

AUTOSCROLL

Controls the display of lines in the LOG and OUTPUT windows

Language element: command
OpenVMS specifics: default values

Syntax
AUTOSCROLL <n | PAGE | MAX>
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no argument
displays the current setting of the AUTOSCROLL command.

n
specifies the number of lines that the window should scroll when it receives a line of
data that cannot fit. The default in the OUTPUT window is 1.

PAGE
specifies in the OUTPUT window only that no lines are displayed until a complete
page of output is written to the window.

MAX
specifies in the OUTPUT window only that no lines are written until the end of each
procedure.

Details Under OpenVMS, the default value for the AUTOSCROLL command in the
OUTPUT window is 1 (meaning that no output is written to that window while
statements are executing, which provides the best performance).

Scrolling can increase the length of time that the SAS System takes to run your
program. The less scrolling that the LOG and OUTPUT windows have to do, the faster
your program will run. Setting the value of n equal to 0 may also speed up interactive
jobs.

See Also

� AUTOSCROLL command in the SAS online Help

CAPS

Changes the default case of text

Language element: command

OpenVMS specifics: All aspects are host-specific

Syntax
CAPS <ON | OFF>

ON
causes characters to be translated to uppercase.

OFF
causes characters to be translated to lowercase

Details The CAPS command is a SAS Text-Editor command.
Under OpenVMS, characters are translated when you move the cursor off the line or

when you press RETURN.
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See Also

� CAPS command in the SAS Text Editor command-line commands portion of the
SAS online Help

COLOR

Changes the color and highlighting of selected portions of a window

Language element: command
OpenVMS specifics: valid field types and attributes

Syntax
COLOR field-type <color | NEXT <highlight>>

Note: This is a simplified description of the COLOR command syntax. For the
complete description, see the COLOR command in the SAS online Help. 4

field-type
specifies the area of the window (such as background, banner, command, border, or
message) or type of text you want to change.

color
specifies the color for the field. On terminals that support color, the following values
are valid:

K black

B blue

C cyan

G green

M magenta

R red

W white

Y yellow

NEXT
specifies to change the color to the next color in the list.

highlight
specifies the highlighting attribute for the field. The following values are valid:

H highlight, which causes the text to be displayed in a bold font.

R reverse video.

U underline.

The B (blinking) attribute is not supported under OpenVMS.

Details The COLOR command allows you to set the color for specific elements of the
active window.
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To save your changes beyond your current session, do one of the following:
� Issue the WSAVE command. The changes are saved to

SASUSER.PROFILE.window.WSAVE.
� From the View menu, select Change display, and then select Save

attributes.

Note: The WSAVE command is not available for all SAS windows. For example,
with SAS/FSP or SAS/CALC software, changes are saved either through the EDPARMS
window or the PARMS window. To determine whether WSAVE is available for a
particular SAS window, refer to the product documentation. 4

Both the COLOR command and the WSAVE command override actions in the
SASCOLOR window. That is, COLOR and WSAVE override the use of CPARMS colors
for that particular window without affecting the CPARMS values for other SAS
windows.

See Also

� COLOR command in the SAS online Help
� WSAVE command in the SAS online Help
�

“Using the SASCOLOR Window” on page 104

DLGABOUT
Opens the About SAS dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGABOUT

Details To open the About SAS dialog box in the active window, select the Help menu
and then select About SAS System.

DLGCDIR
Opens the Change Working Directory dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGCDIR
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Details From the Change Working Directory dialog box, you can select a new working
directory.

To open the Change Working Directory dialog box in the active window, select the
Tools menu, then select Options, and then select Change Directory.

See Also

� “Changing Your Current Working Directory” on page 63
� “Opening Files” on page 61

DLGENDR

Opens the Exit dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGENDR

Details The Exit dialog box prompts you to confirm that you want to exit the SAS
System. If you click on OK in the dialog box, the SAS session ends. If you have set the
SAS.confirmSASExit resource to False, then this command is equivalent to the BYE
command.

To open the Exit dialog box in the active window, select the File menu and then
select Exit.

See Also

� “Miscellaneous Resources” on page 118 for more information about the
SAS.confirmSASExit resource

DLGFIND

Opens the Find dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGFIND
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Details The Find dialog box allows you to search for text strings. To open the Find
dialog box in the active window, select the Edit menu and then select Find.

See Also

� “Searching for Character Strings” on page 64
� Command: “DLGREPLACE” on page 226
� “Replacing Character Strings” on page 65

DLGFONT

Opens the Fonts dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGFONT

Details The Fonts dialog box allows you to dynamically change the font when you are
in the SAS windowing environment. To open the Fonts dialog box in the active window,
select the Tools menu, then select Options, and then select Fonts.

See Also

� “Customizing Fonts” on page 98

DLGOPEN

Opens the Open or Import dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGOPEN <FILTERS=’filters’ <IMPORT> <SUBMIT | NOSUBMIT> <VERIFY>>

no arguments
opens the Open dialog box with the default settings.
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FILTERS=’filters’
specifies one or more file filters to use as search criteria when the SAS System is
displaying files. For example, the following command displays all files in the current
directory that have a .SAS extension and adds *.TXT to the File type combo box in
the dialog box:

DLGOPEN FILTERS="*.sas *.txt"

You can specify multiple filters; they all appear in the File type box. If you do
not specify any filters, the dialog box displays a default list.

IMPORT
opens the Import dialog box, which enables you to import graphics files to your
SAS/GRAPH applications.

SUBMIT | NOSUBMIT
specifies whether the SUBMIT command is pushed after the file is opened.

VERIFY
checks whether the DLGOPEN command is appropriate for the active window.

Details The Open and Import dialog boxes allow you to select a file to read into the
active window. To open the Open dialog box in the active window, select the File menu
and then select Open. To open the Import dialog box in the active window, select the
File menu and then select Import.

See Also

� “Opening Files” on page 61
� “Image Extensions” section in SAS/GRAPH Software: Reference

DLGPREF

Opens the Preferences dialog box

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGPREF

Details The Preferences dialog box allows you to dynamically change certain X
resource settings. To open the Preferences dialog box in the active window, select the
Tools menu, then select Options, and then select Preferences.
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See Also

� “Using the Preferences Dialog Box to Modify X Resource Settings” on page 75

DLGREPLACE

Opens the Replace dialog box

Language element: command

OpenVMS specifics: All aspects are host-specific

Syntax
DLGREPLACE

Details The Replace dialog box allows you to search for and replace text strings. To
open the Replace dialog box in the active window, select the Edit menu and then select
Replace.

See Also

� “Replacing Character Strings” on page 65

� Command: “DLGFIND” on page 223

DLGSAVE

Opens the Save As or Export dialog box

Language element: command

OpenVMS specifics: All aspects are host-specific

Syntax
DLGSAVE <FILTERS=’filters’ <EXPORT> <VERIFY>>

no arguments
opens the Save As dialog box with the default settings.

FILTERS=’filters’
specifies one or more file filters to use as search criteria when you are displaying files.
For example, the following command displays all files in the current directory that
have a .SAS extension and adds *.TXT to the File type combo box in the dialog box:



Commands 4 DLGSCRDUMP 227

DLGSAVE FILTERS="*.sas *.txt"

You can specify multiple filters; they all appear in the file type box. If you omit the
filters, the dialog box displays a default list.

EXPORT
opens the Export dialog box, allowing you to export graphics files in your SAS session.

VERIFY
verifies whether the DLGSAVE command is appropriate for the active window.

Details To open the Save As dialog box in the active window, select the File menu
and then select Save as.

To open the Export dialog box in the active window, select the File menu and then
select Export as Image.

See Also

� “Image Extensions” section in SAS/GRAPH Software: Reference

DLGSCRDUMP

Saves the active GRAPH window as an image file using the filename and file type that you specify

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
DLGSCRDUMP <’filename.ext’ FORMAT=’file-type’>

no argument
opens the Open dialog box and allows you to choose a filename and file type.

’file-specification.ext’
specifies the name of the file you want to open.

FORMAT=’file-type’
specifies the file type of the file you want to open.

Details The DLGSCRDUMP command saves screen captures in any image format
that is supported by SAS/GRAPH software with Image extensions. If your site has not
licensed SAS/GRAPH with Image extensions, then screen captures can be saved only as
.XPM files.
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See Also

� “Opening Files” on page 61
� “Image Extensions” section in SAS/GRAPH Software: Reference

FILE

Writes the contents of the current window to an external file

Language element: command
OpenVMS specifics: valid values for file-specification

Syntax
FILE <filename> <option-list>

file-specification
can be any of the following:

� a single filename. SAS writes the file in the current directory. If you enclose the
filename in quotes, SAS uses the filename exactly as you specify it. If you do not
enclose the filename in quotes and if you do not specify a filename extension,
SAS uses .SAS, .LOG, or .LIS, depending on whether you issue the command
from the PROGRAM EDITOR, LOG, or OUTPUT window. If no filename
extension is specified and the file-specification is longer than eight characters,
then the default value is .DAT.

� an entire pathname. SAS does not assume any filename extensions, even if you
do not enclose the pathname in quotes.

� a fileref.

option-list
specifies portable options for the FILE command. For more information about these
options, see the FILE command in the SAS online Help.

Details The FILE command writes the entire contents of the current window to an
external file without removing text from the window.

You can also use a physical filename (enclosed in quotation marks) in place of the
fileref.

CAUTION:
If you do not specify a filename, then the file from the previous FILE or INCLUDE command
is used. In this case, a requestor window first asks if you are sure you want to
overwrite the file. 4

If you have not issued any FILE or INCLUDE commands, then an error message
informs you that no default file exists. For a list of default file types used for the FILE
command, see “Default File Types” on page 170.

Examples

Example 1: Copying Text from a Window to a File Suppose you have previously
specified the following FILENAME statement:
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filename sasfile ’[mydir]program1.sas’;

Issuing the following FILE command on the PROGRAM EDITOR command line
copies the text from the PROGRAM EDITOR window into the file PROGRAM1.SAS:

file sasfile

Example 2: Appending Text to an Existing External File To append text to an existing
external file, use the APPEND option in the FILE command. For example, you can
issue the following command from the Program Editor window to append the contents
to the file associated with the fileref MYFILE:

file myfile append

See Also

� FILE command in SAS online Help
� “Identifying External Files to the SAS System” on page 166
� “Default File Types” on page 170

FILL
Specifies the fill character

Language element: command
OpenVMS specifics: default character

Syntax
FILL <fill-character>

fill-character
specifies the fill character to be used. Under OpenVMS, the default fill character is
an underscore (_).

Details The FILL command is a SAS Text-Editor command.
The fill characters are placed beginning at the current cursor position. The space will

be filled with the fill character from the current cursor position either to the end of the
line or to the space before the first nonblank character, whichever occurs first.

Under OpenVMS, the default fill character is an underscore (_).

See Also

� FILL command in the SAS Text Editor command-line commands portion of the
SAS online Help

HOME
Toggles the cursor position between current position and home position
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Language element: command
OpenVMS specifics: keyboard equivalent

Syntax
HOME

Details Under OpenVMS, CTRL-F is the default key sequence that executes the
HOME command, which toggles between the last cursor position and the home position
(usually the command line). This behavior is the same in all windows. You can also
define a function key to execute the CURSOR command, which positions the cursor on
the command line but has no toggle effect.

See Also

� HOME command in the SAS online Help

HOSTEDIT

Temporarily suspends the current SAS session and starts a session of the TPU editor

Language element: command
OpenVMS specifics: All aspects are host-specific

Details Under OpenVMS, HOSTEDIT is an alias for the TPU (Text Processing Unit)
command. For more information about this command, see “TPU” on page 234.

INCLUDE

Copies the entire contents of an external file into the current window

Language element: command
OpenVMS specifics: valid values for file-specification

Syntax
INCLUDE <filename> <option-list>

file-specification
can be any of the following:

� a single filename. SAS searches for the file in the current directory. If you
enclose the filename in quotes, SAS uses the filename exactly as you specify it.
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If you do not enclose the filename in quotes and if you do not specify a filename
extension, SAS searches for file-specification.sas.

� an entire pathname. SAS does not assume any filename extensions, even if you
do not enclose the pathname in quotation marks.

� a fileref.

option-list
names portable options for the INCLUDE command. For more information about
these options, see the INCLUDE command in the SAS online Help.

Details The INCLUDE command copies the entire contents of an external file into
the current window.

If you do not specify a file-specification, then SAS uses the filename from the previous
FILE or INCLUDE command. In this case, SAS first asks you if you want to overwrite
the file. If you have not issued any FILE or INCLUDE commands, you receive an error
message indicating no default file exists. For a list of default file types used for the
INCLUDE command, see “Default File Types” on page 170.

Example

Suppose you have previously specified the following FILENAME statement:

filename myfile ’[mydir]oranges.dat’;

The following INCLUDE command includes the file ORANGES.DAT in the PROGRAM
EDITOR window:

include myfile

See Also

� INCLUDE command in the SAS online Help
� “Identifying External Files to the SAS System” on page 166
� “Default File Types” on page 170

RESHOW

Redisplays the windows that are currently displayed

Language element: command
OpenVMS specifics: keyboard equivalent

Syntax
RESHOW

Details If your session is interrupted, by a message from the operating environment
for example, the RESHOW command redisplays the windows that were displayed before
the interruption. By default under OpenVMS, pressing CTRL-R issues the RESHOW
command.
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See Also

� RESHOW command in the SAS online Help

TOOLCLOSE

Closes the toolbox in the active window

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
TOOLCLOSE

Details Use the TOOLCLOSE command to close the toolbox in the active window.

TOOLEDIT

Opens the specified TOOLBOX entry for editing

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
TOOLEDIT <library.catalog.entry>

no argument
edits the toolbox for the active window.

library.catalog.entry
specifies the TOOLBOX entry that you want to edit.

Details If you do not specify an entry name, the Tool Editor opens the toolbox for the
active window. You can then make changes to the toolbox.

TOOLLARGE

Toggles the size of the buttons in the toolbox

Language element: command
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OpenVMS specifics: All aspects are host-specific

Syntax
TOOLLARGE <ON | OFF>

no argument
toggles the size of the toolbox.

ON
sets the size of the buttons in the toolbox to 48x48 pixels.

OFF
sets the size of the buttons in the toolbox to 24x24 pixels.

Details If you do not specify ON or OFF, the TOOLLARGE command toggles the size
of the toolbox. The size of the toolbox changes for your current session only; the new
size is not saved.

To change the size of the toolbox in the active window, select the Tools menu, then
select Options, and then select Preferences. This opens the Preferences dialog box.
Select the Toolbox tab, then select Use large tools. If you change the size of the
toolbox through the Preferences dialog box, the new size is saved, and the SAS System
will display the large toolbox in subsequent sessions.

TOOLLOAD
Loads the specified toolbox

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
TOOLLOAD < library.catalog.entry>

no argument
loads the toolbox for the active window.

library.catalog.entry
specifies the catalog entry to load.

Details If you do not specify a catalog entry, the TOOLLOAD command loads the
toolbox for the active window. After this command is processed, the specified toolbox is
the active toolbox.

TOOLTIPS
Toggles the tool-tip text for an icon on and off
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Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
TOOLTIPS <ON | OFF>

no argument
toggles the tool-tip text on and off.

ON
specifies that the tool-tip text is displayed when you move the cursor over an icon in
the toolbox.

OFF
specifies that the tool-tip text is not displayed.

Details The TOOLTIPS command specifies whether the tool-tip text is displayed when
you move the cursor over an icon in the toolbox. If you do not specify either ON or OFF,
the TOOLTIPS command toggles the text on and off, depending on the current setting.

See Also

� “Changing an Existing Tool” on page 85

TPU

Temporarily suspends the current SAS session and starts a session of the TPU Editor

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
TPU | HOSTEDIT | HED

TPU
suspends your SAS session and opens a session of the TPU Editor.

HOSTEDIT
is an alias for the TPU command.

HED
is an alias for the TPU command.

Details The TPU command (or its aliases, HOSTEDIT or HED) enables you to use
the OpenVMS Text Processing Utility (TPU) editor for editing instead of the default
SAS Text Editor. You can also invoke the TPU editor from the Program Editor by
pressing CTRL-N.
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The command suspends your SAS session and initiates a session of the TPU Editor.
When this session begins, the TPU window displays the contents of the window from
which it was invoked, and the name of the window is displayed on the TPU status line.
You can then edit the window’s contents.

� If you have write access to the window (such as the Program Editor window), then
you can save the changes that you make during the TPU session to the window
when you exit from the editor, or you can save the changes to an external file.

� If you have only read access to the window, then a message on the message line of
the TPU window alerts you to this fact. When you exit from the editor, you can
save your changes to an external file, but you cannot save them to the window.

Special text attributes such as color or highlighting are lost during a TPU editing
session. Therefore, when you issue the TPU command from a window that contains text
with these attributes, a requestor window appears. The requestor window enables you
either to continue or abort the TPU command.

To suppress this warning, issue the HEATTR OFF command from the window’s
command line before you invoke TPU. Text attributes will then be deleted without
warning. To redisplay the warning message, issue the HEATTR ON command from the
window command line, then issue the TPU command.

When you have finished editing in a TPU session, do one of the following:

� To save the changes to the window, use the CTRL-Z key sequence or type EXIT at
the TPU command prompt.

� To discard the changes you made, type QUIT at the TPU command prompt.

� To save the contents of the window to an external file, use the standard TPU
commands. Then use the CTRL-Z command or the QUIT command, depending on
whether you also want to save the changes to the window.

In each case, you are returned to the window in the SAS session that was suspended.
You can undo any changes you made to the window text during that session by issuing
the UNDO command from the window command line.

UNDO

Undoes one line of text entry

Language element: command

OpenVMS specifics: command behavior

Syntax

UNDO

Details The UNDO command is a SAS Text-Editor command.
Under OpenVMS, executing the UNDO command once undoes one line of text entry.

For example, suppose you have entered three lines of text. You must issue the UNDO
command three times to undo all three lines.
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See Also

� UNDO command in the SAS Text Editor command-line commands portion of the
SAS online Help

WBROWSE

Invokes a World Wide Web browser

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
WBROWSE <“URL”>

no argument
invokes the World Wide Web browser specified by the X resource.

“URL”
specifies a URL (Uniform Resource Locator), which contains the server and path
information needed to find a document on the Internet or on a local intranet. The
value for URL must be enclosed in double quotation marks.

Details By default, the WBROWSE command invokes the World Wide Web browser
that is specified by the X resource SAS.webBrowser. If you specify a URL, the
document that the URL identifies is displayed instead. Note that you must enclose the
URL in double quotation marks.

See Also

� “Miscellaneous Resources” on page 118 for more information about the
SAS.webBrowser resource

WCOPY

Copies the marked contents of the active window to the default buffer

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
WCOPY
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Details The WCOPY command is a SAS Text-Editor command.
If the active window is a base SAS window, SAS issues the STORE command. If the

active window is a SAS/GRAPH window, SAS issues the GSTORE command. If the
active window is a SAS/IMAGE window, SAS issues the IGEMOVE command.

WCUT

Moves the marked contents of the active window to the default buffer

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
WCUT

Details The WCUT command is a SAS Text-Editor command.
If the active window is a base SAS window, SAS issues the CUT command. If the

active window is a SAS/GRAPH window, SAS issues the GSTORE command. If the
active window is a SAS/IMAGE window, SAS issues the IGECCLPB command.

WPASTE

Pastes the contents of the default buffer into the active window

Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
WPASTE

Details The WPASTE command is a SAS Text-Editor command.
If the active window is a base SAS window, SAS issues the PASTE command. If the

active window is a SAS/GRAPH window, SAS issues the GPASTE command. If the
active window is a SAS/IMAGE window, SAS issues the IGEPCLPB command.

WUNDO

Undoes one line of text entry
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Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
WUNDO

Details The WUNDO command is a SAS Text-Editor command.
If the active window is a base SAS window or is a SAS/IMAGE window, SAS issues

the UNDO command. If the active window is a SAS/GRAPH window, WUNDO is not a
valid command.

Under OpenVMS, executing the WUNDO command once undoes one line of text
entry. For example, suppose you have entered three lines of text. You must issue the
WUNDO command three times to undo all three lines.

X

Enters host-system mode or allows you to submit a DCL command without ending your SAS session

Language element: command
OpenVMS specifics: valid values for DCL-command; syntax

Syntax
X <’>DCL-command<’>

DCL-command
specifies the DCL command that you want to execute. If the SAS System recognizes
the value for DCL-command as a valid DCL command, then no quotation marks are
needed. However, code is easier to read if quotation marks appear around the DCL
commands.

Details This form of the X command issues one DCL command. The DCL command
is passed to the operating environment and executed. If errors occur, the appropriate
error messages are displayed.

See Also

� X command in the SAS online Help
� “Issuing DCL Commands during a SAS Session” on page 36

XSYNC

Changes X synchronization during a SAS session
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Language element: command
OpenVMS specifics: All aspects are host-specific

Syntax
XSYNC ON | OFF

no argument
toggles the synchronization events reporting between current and future.

ON
specifies to report synchronization events as they occur.

OFF
specifies to report synchronization events at a later time.

Details If X synchronization is on, events are reported as they occur. If X
synchronization is off, events are reported at some later time, such as when you press
the RETURN key. X synchronization is off by default. Turning it on is useful when you
are debugging applications, although it drastically reduces performance.

If you do not specify ON or OFF, the XSYNC command toggles the synchronization.
You can issue the XSYNC command from any SAS window.

Function-Key Commands
The SAS System under OpenVMS provides many windowing environment commands

in addition to those that are documented in the SAS online Help. These host-specific
commands are described in Table 11.1 on page 239.

Before you use these commands, be aware of several special considerations:
� Each of these commands is the only definition for a function key; that is, the

command cannot be combined with any other command. For example, the
following is a valid key definition:

PF1 CURSORUP

The following key definitions are not valid:

PF1 HOME; CURSORUP

PF2 CURSORUP; CURSORUP
� You cannot specify any of these commands in the DM statement.
� You cannot enter any of these commands on a command line except where noted in

the description.

If you use one of these commands incorrectly, you receive a message that the given
use is not supported.

Table 11.1 Host-Specific Windowing Commands Under OpenVMS

Command Description

CHINSERT Toggles insert mode.

CURSORDOWN Moves the cursor down.

CURSORLEFT Moves the cursor left.
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Command Description

CURSORRIGHT Moves the cursor right.

CURSORUP Moves the cursor up.

DELCHAR Deletes the character at the cursor location.

DELLINE Deletes all characters on the current line.

DELPCHAR Deletes the character to the left of the cursor.

DELTOEOL Deletes all characters to the end of the line.

DELWORD Deletes the word under the cursor.

KP_APPLICATION See KP_NUMERIC.

KP_NUMERIC Puts the application keypad into numeric mode. Numeric mode is convenient to use in
data entry where numbers are involved. The KP_APPLICATION command returns the
keypad to application mode, so that the keypad keys resume their functionality listed in
the KEYS window. You can issue this command from the command line.

MOVEBOL Moves to the beginning of the line.

MOVEEOL Moves to the end of the line.

NEWLINE If there is a command on the command line, NEWLINE executes it; otherwise, the cursor
moves to the beginning of the next line (equivalent to a carriage return).

NEXTFIELD Moves to the next field. This command does not move the cursor from the command line;
use the HOME (CTRL-F) command to move from the command line.

NEXTWORD Moves to the next word.

PREVFIELD Moves to the previous field. This command does not move the cursor from the command
line; use the HOME (CTRL-F) command to move from the command line.

PREVWORD Moves to the previous word.

Host-Specific Frames of the FORM Window
The FSFORM command activates a series of window frames collectively called the

FORM window, which enables you to specify the printer, text format, and destination
for your output. This capability is useful when you issue the PRINT command and
when you print from SAS/AF and SAS/FSP procedure output. (For more information,
see Chapter 8, “Routing the SAS Log and SAS Procedure Output,” on page 187 and the
FSFORM command in the SAS online Help.)

To invoke the FORM window, issue the following command:

FSFORM form-name.FORM

The first frame that you see after issuing the FSFORM command is the Printer
Selection window. This window enables you to specify which printer you want to use.
Display 11.1 on page 241 shows the default information for this window under
OpenVMS.
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Display 11.1 Printer Selection Window

Note: The information in the Printer Selection window is also site-dependent, so
your window may look slightly different. 4

The Printer Selection window appears only the first time you create a print form.
After you modify a form, it is stored in your SASUSER.PROFILE catalog (entry type
FORM).

The next time you modify this form, the Printer Selection window is skipped. You
cannot return to the Printer Selection window from the second FORM window frame.

The third FORM window frame is also host-specific. This frame has two parts: the
OpenVMS Print File Parameters window frame and the OpenVMS Job and Page
Definitions window frame.

Note: The information in these window frames is site-dependent, so your window
frames may look slightly different from those shown in Display 11.2 on page 242 and
Display 11.3 on page 243. 4

OpenVMS Print File Parameters Window Frame
The first part of the third FORM window is the OpenVMS Print File Parameters

window frame (shown in Display 11.2 on page 242). The OpenVMS print file
parameters displayed in this window frame are the same parameters that you would
use in an OpenVMS PRINT command. This window frame provides field-specific help.
To receive help on a field, place your cursor on that field and press the HELP function
key. In addition to the help given in this window, you can also request help on the
PRINT command by using the OpenVMS Help Facility.
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Display 11.2 OpenVMS Print File Parameters Window Frame

The following fields appear in the OpenVMS Print File Parameters window frame:

Printer queue
sends output to the specified queue. If no queue is specified, the default is
SYS$PRINT. Filling in this field is equivalent to using the QUEUE= option in the
OpenVMS PRINT command. Do not include quotation marks in the queue
specification. The value can contain up to 31 characters.

Job name
specifies the output name. The name is specified using 1 to 39 alphanumeric
characters. The default is the name of the file being submitted. Filling in this field
is equivalent to using the NAME= option in the OpenVMS PRINT command,
except that the job name cannot contain any spaces or quotation marks.

Issuing the SHOW QUEUE command from the DCL prompt displays the job
name. The job name is also printed on the flag page for the output.

Number of copies
specifies the number of copies of the output that you want to receive. The number
of copies defaults to 1, but it can be specified from 1 to 255. Filling in this field is
equivalent to using the COPIES= option in the OpenVMS PRINT command.

Job characteristics
specifies one or more characteristics, separated by commas, for your output. The
list of characteristics cannot contain any spaces. For example, you can specify the
following:

LOWER,DOUBLE

Job characteristics are site- and printer-specific; see your system manager for
information on what characteristics are available for your printers. Filling in this
field is equivalent to using the CHARACTERISTICS= option in the OpenVMS
PRINT command, except that the specification may not include parentheses or
quotation marks.

Parameters
specifies one or more parameters, separated by commas, for your output. The list
of parameters cannot contain any spaces. These parameters are site-specific; see
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your system manager for information on what parameters are available. Filling in
this field is equivalent to using the PARAMETERS= option in the OpenVMS
PRINT command, except that the specification cannot include parentheses or
quotation marks. You can specify up to eight parameters.

Date/time for print
can be used to hold the output until the date and time specified. Use absolute date
and time to specify the day and time the output is printed. (That is, specify 12:00,
not “3 hours from now.”) Enter values from left to right. You do not need to fill in
each field, but each field to the left of one that is entered must be filled in. Filling
in this field is equivalent to using the AFTER= option in the OpenVMS PRINT
command, except that the date and time specification cannot include quotes.

Job termination parameters:

Do not notify when done
specifies whether you are notified when the output has been printed. By
default, you are notified when your job is finished. Filling in this field is
equivalent to using the NOTIFY= option in the OpenVMS PRINT command.

Do not restart
specifies whether to restart the printing of the output when a crash occurs or
if a stop/requeue command is issued. By default, jobs are restarted. This field
is equivalent to using the RESTART= option in the OpenVMS PRINT
command.

OpenVMS Job and Page Definitions Window Frame
The second part of the third FORM window frame is the OpenVMS Job and Page

Definitions window frame. This window frame is shown in Display 11.3 on page 243.
You display this window frame by placing the cursor on the SELECT field at the bottom
of the OpenVMS Print File Parameters window frame (described in “OpenVMS Print
File Parameters Window Frame” on page 241) and pressing RETURN.

Display 11.3 OpenVMS Job and Page Definitions Window
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The following fields appear in the OpenVMS Job and Page Definitions window frame:

Print form name:
specifies the name of the form that is used for the print queue. Filling in this field
is equivalent to using the FORM= option in the OpenVMS PRINT command.
These forms are site-dependent. See your system manager for information about
which forms are available.

Flag page message:
specifies the message to be printed on the flag page. Filling in this field is
equivalent to using the NOTE= option in the OpenVMS PRINT command, except
that the message cannot contain any spaces or quotation marks.

Job definition parameters

Print flag page
controls whether a flag page is printed before the output. The flag page
displays the name of the user submitting the output and other information
about the output being printed. By default, no flag page is printed. Filling in
this field is equivalent to using the FLAG= option in the OpenVMS PRINT
command.

Print burst page
specifies whether a flag page is printed over the perforation in the paper so
that the output is easily identified. By default, no burst page is printed.
Filling in this field is equivalent to using the BURST= option in the
OpenVMS PRINT command.

Print trailer page
specifies whether to print a trailer page at the end of the output. The trailer
page has the name of the user submitting the output and other information
about the output being printed. By default, no trailer page is printed. Filling
in this field is equivalent to using the TRAILER= option in the OpenVMS
PRINT command.

Passall
specifies whether all formatting is bypassed and sent to the printer with
formatting suppressed. By default, formatting is used. Filling in this field is
equivalent to using the PASSALL= option in the OpenVMS PRINT command.

Page definition parameters

Form feed
specifies whether form feeds occur within the last four lines of the page when
printing is taking place. By default, no form feeds are performed. Filling in
this field is equivalent to using the FEED= option in the OpenVMS PRINT
command.

Double space
specifies whether to double-space the output. By default, the output is
single-spaced. Filling in this field is equivalent to using the SPACE= option
in the OpenVMS PRINT command.

Title each page
specifies whether to print a title on each page of output. By default, no titles
are printed. Filling in this field is equivalent to using the HEADER= option
in the OpenVMS PRINT command.
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